¢ Note bem: este méddulo foi m

inicialmente concebido para uma cadeira
do 3° semestre, pelo que, os alunos que
nunca tiveram contacto com um
ambiente de programagio terio uma
natural dificuldade em alguns dos temas
focados.

Introducao ao Matiab

TOPICOS
Ambiente de Trabalho

Representacio, Declaragdo e Afectagio

Representacio Grafica

Complexos

Controlo de Fluxo

Alocagio de Memoéria. Vectorizagio

Scripts e Fungdes

Calculo Simbélico

m paralelo com ITI, esta é a primeira de um grande conjunto de cadeiras em que, ao
longo do seu curso, vai recorrer a0 ambiente de trabalho e a linguagem Matlab para
resolver problemas e ilustrar conceitos do 4mbito das matérias especificas de cada uma
das cadeiras. E essencial que desenvolva uma base solida no dominio da linguagem
Matlab, e este & 0 momento em que deve tomar, seriamente, a decisdo de construir essa base.

Este 1° modulo apenas pretende fazer uma breve introdugdo ao ambiente de trabalho Matlab, de
modo a que, em pouco tempo, consiga dominar as funcionalidades basicas do ambiente e da
linguagem.

Optou-se pela ndo enumeragio exaustiva de todas as funcionalidades do Matlab, que se considera
enfadonha e inGtil sem que se apresentem exemplos especificos de aplicacio, justificativos do
conhecimento dessas mesmas funcionalidades. Ao longo dos médulos seguintes, e a titulo
exemplificativo dos conceitos tedricos que entdo se desejem esclarecer, serdo propostos exercicios
com recurso ao Matlab, sendo progressivamente apresentadas as potencialidades do ambiente de
programacio, as fungdes de base, e, especificamente, as pertencentes a foolboxes, que constituem
um vasto conjunto de funcdes que permitem resolver rapida e eficientemente problemas de
grande complexidade em diversas areas de interesse, como sejam as do processamento de sinal,
processamento de imagem, desenho de filtros, comunicagdes, controlo, etc.

A leitura deste mddulo, como alias a de todos os seguintes, devera ser feita na presenga de um
PC com o Matlab instalado, de modo a que possa reproduzir os exemplos dados e fazer os
€Xercicios propostos.
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1. Ambiente de trabalho

Consola

Abra o Matlab. Dentro da janela Matlab é provavel que existam diversas subjanelas (dependendo
das pré-defini¢des do seu ambiente de trabalho), como, por exemplo, as sub janelas Workspace,
Command History, e Command Window, tendo o ambiente de trabalho o aspecto tipico
representado na figura seguinte.

-} MATLAB
File Edit Wiew ‘eb wWindow Help

6w o2

Currert Cirectory: | CIMATLABERS wvork v | E]

Cornmand

[E3[E3

= stad{;l:l Using Toolbox Path Cache. Type "help ©

Name dize E To get started, select "MATLAE Help™ fr
>

< >

Comrmand History

1s ~

cd Seml

Feche todas as janelas existentes para além da consola (Command Window). Por enquanto a
consola é a Gnica janela de que vai necessitar. O ambiente de trabalho deve ficar com o aspecto
representado na figura seguinte.

File Edit Wwiew MWeb ‘Window Help

0= i) | 2 | current Directory: | comaTLABBRSWork v|[]

Tzing Toolbox Path Cache. Type "help toolbox_path cache™ for more infa.
To get started, select "MATLAE Help”™ from the Help menu.

> |

Mude para a sua directoria de trabalho. Pode fazelo quer através de uma operagio de browsing
no menu Current Directory, quer através de um comando na consola. Por exemplo

>> cd d:\work

Note que o Matlab aceita a maioria dos comandos basicos DOS e UNIX (por exemplo: cd ;
dir; 1s; pwd; etc.). Na maioria dos casos é mais simples recorrer aos comandos de consola do
que a operagdes de rato sobre icons. Se quizer saber a directoria em que se encontra use O
comando pwd. Se quizer listar os ficheiros existentes nessa directoria use o comando Is.

Operacoes aritméticas simples
Pode utilizar a consola para executar operagdes aritméticas simples, ou seja, como uma vulgar
maquina de calcular. Por exemplo uma operagio de adi¢io

>> 243
ans =
5

© Prof. José Amaral ALGA MO0 - 2 26-09-2007
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, ou de multiplicagio

>>3%2
ans =

6

As operagdes respeitam as regras de precedéncia comuns. Sempre que necessirio ou sempre que
tenha davidas utilize parénteses

>> 5*243%4/(4-5)
ans =
-2

Reposicao de comandos

Pressione o cursor A e verifique que o Matlab repde a ultima linha interpretada pela consola.
Pressionar o cursor A sucessivamente e verifique que todos os comandos interpretados
anteriormente sio repostos ordenadamente.

Se desejar repor um qualquer comando anteriormente interpretado, digite ofs) primeiro(s)
caracter(es) desse comando e pressione seguidamente o cursor 4. Neste caso, a pressio sucessiva
do cursor A apenas repde os comandos anteriormente interpretados que comecem pelo(s)
carcter(es) que digitou.

Ficheiros .m
Sempre que seja necessario executar diversas linhas de codigo, deve habituarse a criar um
ficheiro .m. Execute o comando

>> edit exemplol.m

, Ou recorra a0 menu File->New->M-file, conforme descrito na figura seguinte, para abrir a janela
do editor associado ao Matlab.

=} MATLAB

File Edit wiew Web Window Help
M-File ectory: | CDocuments and Settingstjdaiby | E]
Cpen... ChrHO Figure .
Close Command Window ChrH- Model
[e1H))

Irnport Data...
Save Workspace As...

—

Reescreva os comandos anteriormente escritos na janela da consola, salve o ficheiro com o nome
exemplol.m, €, na linha de comando, escreva o nome do ficheiro (sem a extensio)

i=1[Ed

File Edit “ew Text Debug Breakpoints web Window Help
Dl s S | @ F %) I sm:[
1 243
2 3FE
3 5*2+374/ (4-5)|
>> exemplol
ans =
5
ans =
6
ans =
-2
© Prof. José Amaral ALGA MO0 - 3 26-09-2007
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Como pode verificar, todas as linhas de c6digo sdo interpretadas sucessivamente como se
fossem apresentadas na linha de comando da consola.

Para além de assim poder guardar todos os comandos que executa sobre a consola, o editor
permite-lhe, como é vulgar nos outros ambientes de programagio, identar o codigo para uma
mais facil leitura, proceder ao debuging, etc..

Sempre que desejar pode inserir comentarios, ou passar a comentario as linhas de codigo que

nio deseja executar, utilizando para isso o caracter %. O modo mais facil de comentar diversas
linhas de c6digo € através do menu Text->Comment, conforme a figura seguinte

File Edit Wiew  Text Cebug Breakpoints ‘Web  Window Help

0= E cl? Evaluate Selection

1 3 Format Selected Comments
Cormmenkt
3 3 Uncomment Chrl+T

Help

Sempre que necessitar de ajuda sobre qualquer das funcionalidades do Marlab pode recorrer aos
comandos lookfor ¢ help. Por exemplo, para obter informagio sobre os operadores existentes em
Matlab pode fazer

>> lookfor operators

arith.m: %$Arithmetic operators.

relop.m: %$Relational operators.

>> [Ctrl+C]

>> help arith

Arithmetic operators.

+ Plus.

X + Y adds matrices X and Y. X and Y must have
the same dimensions unless one is a scalar

Se desejar informagio mais detalhada pode recorrer a0 menu Help->MATLAB Help, abrindo
assim a janela Help do Matlab, e fazer uma busca full text sobre operators

Fil= Edit Wew Go Web ‘Window Help

Help Mavigatar
T L —

Praduct fiter: (@) &Il () Selected
| MATLAB Functions: Arithmet + | | Add to Favorites |

Contents ~ Index  Search  Demos Farn =
Search type: |Fu|| Text - | MATLAB Function Reference €]
Search for: ||:|pera‘tc|r3 v| Ar'thmet'c Operators + -

* _1'”\"\ 1
Examale  airking ANMD fgues A0 T exooidim
Title Matrix and array arthmetic
Installer L
MATLAB Directory Structure Syntax
L+E
MATLAB L-B
L*E L.*E
Logical Operatars, El twise & A/E A./E
ogical Operators, Element-wise & | ~ B LAE
Operators and Operations I L.ME
Logical Operators, Sho-circuit & || it it
Logical Operators, Element-wise & | ~
Relational Operators = = 2= ==== = Description
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2. Representacao, declaracao e afectacao

O Matlab armazena as quantidades numéricas e opera sobre estas utilizando precisao dupla, ou
seja, sdo utilizados 64 bits para a representacio interna, sendo 1 bit para o sinal, 11 bits para o
expoente, e 52 bits para a mantissa. Contrariamente a outras linguagens de programagio nio
existe a necessidade de declarar o tipo de representagdo interna com que se deseja trabalhar.

Nio confunda a representagio interna, o “verdadeiro” valor da quantidade numérica que esta a
operar, com a representa¢io externa, isto é, com o valor da quantidade numérica que é mostrado
na consola. O valor mostrado na consola, ou, mais exactamente, o formato com que a
quantidade numérica é apresentada na consola, é controlado por si através do comando format.
Execute

>> format short
>> 3/7
ans =
0.4286

>> format long
>> 3/7
ans =

0.42857142857143
>> format short e
>> 3/7
ans =

4.2857e-001

Execute 0o comando help format para um completo esclarecimento sobre todos os formatos
disponiveis.

Pode utilizar varias notagdes para enumerar as quantidades numéricas. Por exemplo, a
quantidade 0.04 pode ser enunciada de diversos modos

>> 0.04;

>> 4*107-2;

>> 4e-2

ans =
0.0400

Como se disse, em Matlab, nio existe a necessidade de declarar o tipo de uma variavel antes da
sua utilizagio. A operagio de declaragio e afectagio é feita simultaneamente através do operador
=. Por exemplo, podemos declarar a variavel a e atribuirlhes o valor inteiro 2

>> a=2
a =

Note que pode evitar que seja feito eco na consola do resultado das linhas de codigo terminando
cada uma delas com o operador ;

>> a=2;
Podemos de seguida declarar a variavel b e atribuir-lhe o valor real 3.14

>> b=3.14;

No nome das variaveis, o Matlab distingue as letras maitsculas das mintsculas, s6 atendendo aos
primeiros 31 caracteres.

Podemos verificar que as varidveis a e b passaram a existir no espaco de trabalho através do
comando who

© Prof. José Amaral
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>> who
Your variables are:
a b

Se utilizarmos o comando whos, para além do nome das variveis énos dada informagio sobre
a dimensio (size) das variaveis, espaco ocupado em membria, etc.

>> whos
Name Size Bytes Class
a 1x1 8 double array
b 1x1 8 double array

Note que qualquer das variaveis é representada internamente como um valor real em formato
double (8 bytes =8x8bits=64bits). Note ainda que qualquer delas é referida como tendo dimensio
1x1. O que isto significa é que qualquer delas é considerada como sendo uma matriz, no caso
uma matriz com uma linha e uma coluna. No nome Matlab, “Mat” nio é, como poderia pensar,
a abreviatura de Mathematic, mas sim de Matrix. Na verdade as matrizes formam o nucleo do
Matlab sendo todos os dados considerados como tal (por exemplo: um escalar € uma matriz 1x1;
um vector é uma matriz linha ou uma matriz coluna).

Se quiser eliminar uma variavel do espago de trabalho utilize o comando clear <variavel>, Se
quiser eliminar todas as variaveis utilize o comando clear all.

Ja vimos como definir uma variavel escalar. Vamos agora ver como definir um vector. O modo
mais 6bvio é por enumeragdo das suas componentes, por exemplo

>> v=[0 1 2 3]
v =

0 1 2 3

define um vector linha com 4 elementos, na verdade, nio esquega, define uma matriz com 1
linha e 4 colunas. Podemos verificar tal facto com a funcio size

>> size (v)
ans =
1 4

Como v&, a variavel v é considerada como sendo uma matriz com 1 linha e 4 colunas. Podemos
ter necessidade de definir um vector coluna. Nesse caso devemos enumerar os elementos do
vector separados pelo operador ;

>> v=[0; 1; 2; 3]
v =

w N P o

Podemos verificar que temos agora uma matriz com 4 linhas e 1 coluna

>> size (v)
ans =
4 1

Se o vector a definir tiver uma qualquer relagio entre os seus elementos, é possivel definilo de
modo mais pratico do que por enumeragio, recorrendo ao operador :. Por exemplo, para definir
um vector de elementos equiespagados de 1 entre o valor inicial -4 ¢ o valor final 3 basta fazer

>> v=-4:3
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Se o equiespagamento ndo for unitario basta referi-lo. Por exemplo, para definir um vector de
elementos equiespacados de 0.1 entre o valor inicial 4.3 e o valor final 4.6 basta fazer

>> v=4.3:0.1:4.6
v =
4.3000 4.4000 4.5000 4.6000

Sempre que seja necessario transformar um vector linha num vector coluna, e vice-versa, o modo
mais eficiente de o fazer é recorrer a transposigao, utilizando o operador ¢, por exemplo

>> v=v'

v =
4.3000
4.4000
4.5000
4.6000

Note que no caso em que os elementos do vector sejam quantidades complexas a transformacio
de um vector linha num vector coluna nio é equivalente a operagio de transposi¢io. Recorde da
4lgebra que existe neste caso uma operagio de conjugac¢io dos elementos. Assim

>> a=[1-23 3-473]
a =
1.0000
>> a'
ans =
1.0000 + 2.000041
3.0000 + 4.00001
>> conj(a')
ans =
1.0000 - 2.00001
3.0000 4.00001

2.00001 3.0000 - 4.00001

Existem métodos mais sofisticados de definir vectores, e vectores especiais, de que falaremos mais
tarde, quando for necessaria a sua utilizago.

Uma matriz é igualmente simples de definir por enumeragio. Por exemplo

>> A=[1 2 3 4; 56 7 8; 9 10 11 12]

A =
1 2 3 4
5 6 7 8
9 10 11 12

, define, como vé, uma matriz com 3 linhas e 4 colunas, composta pelos elementos enumerados,
devendo cada uma das linhas ser separada pelo operador ;. Poderiamos ter feito

>> A=[1:4;5:8;9:12]
A:

O elemento da linha ¢ e da coluna j de uma matriz A € designado por A(%, j), sendo os

indices inteiros positivos. Por exemplo, para seleccionar o elemento da linha 2 e coluna 3 da
matriz definida anteriormente fazemos

>> A(2,3)
ans =
7
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Se pretendermos alterar este valor, por exemplo para 0, basta fazer

>> A (2,3)=0
A =

Para seleccionar uma linha ou uma coluna completa recorremos ao operador .. Por exemplo

>> A(2,:)
ans =
5 6 0 8
>> A(:,3)
ans =
3
0
11

E igualmente facil seleccionar uma submatriz. Por exemplo, se quisermos seleccionar os
elementos das linhas 2 e 3, colunas 2 a 4 podemos fazer

>> A([2 3],[2 3 4])
ans =

10 11 12
, ou, simplesmente

>> A(2:3,2:4)
ans =

10 11 12

Os elementos de uma matriz podem ainda ser seleccionados sequencialmente, sendo a
enumeracio feita ao longo das colunas, da direita para a esquerda. Por exemplo

>> A(2:5)
ans =

5 9 2 6
>>

Para remover qualquer conjunto de linhas ou colunas de uma dada matriz, basta atribuir uma
matriz vazia as linhas e colunas que se pretende remover. Por exemplo, recordando a matriz A

>> A=[1:4;5:8;9:12]

A =
1 2 3 4
5 6 7 8
9 10 11 12
>>

podemos remover facilmente a 2% coluna da matriz
>> A(:,2)=[]

A =

>>
,oua 3?linha

>> A(3,:)=[]
A =
1 2 3 4
5 6 7 8
>>
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A operagio de juntar varias matrizes, ou vectores, numa s6é matriz é designada por
concatenagio. Por exemplo

>> A=[1 2;3 4]

A:
1 2
3 4
>> B=[5 6;7 8]
B =
5 6
7 8
>> C=[A B]
C:
1 2 5 6
3 4 7 8
>> C=[A; B]
C:
1 2
3 4
5 6
7 8

Uma matriz de zeros é facil de criar em Matlab, recorrendo i fungzo zeros

>> B=zeros (2,3)

B =
0 0 0
0 0 0
>>
Tem especial interesse, a curto prazo, a criagio de um vector linha, ou coluna, contendo apenas

ZEeros

>> Vl=zeros(1l,3)

vVl =

0 0 0
>> V2=zeros(3,1)
V2 =

0

0

0
>>

Note que quando se pretende criar um vector é necessario especificar duas dimensdes, uma delas,
evidentemente, igual a 1. Um erro comum ¢é a especificagdo de apenas uma dimensio. Note que
nesse caso € criada uma matriz quadrada, da dimensio especificada, e ndo um vector

>> zeros (4)

ans =
0 0 0 0
0 0 0 0
0 0 0 0
0 0 0 0
>>

De igual interesse € a criagio de uma matriz de uns. Recorremos para isso a fungéo ones

>> C=ones (3,2)

c =
1 1
1 1
1 1
>>

Para um vector linha, e coluna, temos, evidentemente

>> Vl=ones (1l,3)

vl =

1 1 1
>> V2=ones (3,1)
V2 =
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fay

>>
Vimos que é facil criar um vector com um valor inicial, um incremento, e um valor final

>> v=0:0.5:3
v =

0 0.5000 1.0000 1.5000 2.0000 2.5000 3.0000
>>

Esea intengéo for criar um vector com um valor inicial, um valor final, e um dado numero de
elementos? Por exemplo, valor inicial 0, valor final 3 e 6 elementos. Bom, podemos pensar
que se trata de um problema de dividir o espaco num ntimero de intervalos, ou seja de ter um
incremento igual & dimensdo do intervalo, a dividir pelo nimero de elementos menos 1, e por
1ss0

>> v=0:(3-0)/5:3
v =

0 0.6000 1.2000 1.8000 2.4000 3.0000
>>

Alternativamente, podemos recorrer A fungéo linspace

>> v=linspace (0,3, 6)
v =

0 0.6000 1.2000 1.8000 2.4000 3.0000
>>

Uma consequéncia directa das entidades numeéricas serem sempre consideradas matrizes é o facto
de os operadores serem por defeito considerados operadores matriciais. Assim, os operadores +, -
, *, 1 e %, s3o, nao esquega, operadores matriciais.

Operagio Operador
Adigio +
Subtraccio -
Multiplicagio *
Divisdo !
Potenciagio "

Estes operadores podem ser usados com quantidades escalares dado que ndo existe qualquer
problema em manipular matrizes 1x 1, no entanto, quando aplicados a vectores ou matrizes é
evidentemente necessario respeitar as regras do calculo matricial. Por exemplo, é muito comum
que, quando se pretende elevar os diversos elementos de um vector v ao quadrado se escreva

>> vh2

??? Error using ==> "
Matrix must be square.
>>

,ou que, quando se pretende multiplicar dois vectores elemento a elemento se escreva

>> v*v

??? Error using ==> *

Inner matrix dimensions must agree.
>>

Elevar os diversos elementos de um vector a uma poténcia e multiplicar dois vectores elemento a
elemento, sdo dois exemplos de operagées elemento a elemento (ponto a ponto), devendo ser
utilizados os operadores .*, ./ e .» . No caso da adi¢io e da subtrac¢io nio existe qualquer
diferenca entre os operadores.
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Operagio Operador
Multiplicagio ponto a ponto -
Divisio ponto a ponto J
Poténcia ponto a ponto A

Por exemplo, podemos definir dois vectores

>> v=[2 3 4];
>> w=[5 6 7];
>>

E proceder a uma operagio matricial de multiplicagio, ou divisio

>> viw!
ans =
56
>> w/v
ans =
1.9310
>>

que sera executada sem erro se estiverem verificadas as condi¢des para que a operagdo matricial
seja efectuada (note que no caso da multiplicagio foi necessario transpor um dos vectores). Caso
as operagdes desejadas fossem, por exemplo, a multiplicagio ou divisio dos dois vectores ponto a
ponto, deveriamos fazer

>> v.rw
ans =
10 18 28
>> w. /v
ans =
2.5000 2.0000 1.7500
>>

A confusido inadvertida entre os dois tipos de operagio é muito comum. Tome sempre isto em
muita atengdo na escrita do cddigo. Note que por vezes a confusdo entre as operagdes matricial e
ponto a ponto pode nio ser detectada, por estar imersa numa sequéncia de calculos. Considere a
matriz

>> A=[ 2 3; 4 5]

A =
2 3
4 5
>>
Note que
>> AN2
ans =
16 21
28 37
>>

¢ uma operagio matricial possivel, devido ao facto da matriz ser quadrada, que nada tem a ver
com operagao ponto a ponto

>> A2
ans =
4 9
16 25
>>

Para os operadores relacionais em Matlab sio utilizados os simbolos

Igual | Diferente | Menor Maior Menor ou Igual Maior ou Igual

== ~= < > <= >=

© Prof. José Amaral
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A operagio de comparagdo devolve 1 se a relagio se verificar e 0 se ndo se verificar. Por exemplo

>> a=2;
>> b=2;
>> c=(a==b)
c =
1

>>
Como foi referido, o Matlab armazena as quantidades numéricas utilizando precisio dupla, ou
seja, utilizando uma mantissa com 52 bits. A precisio de representagdo é portanto finita. Sempre
que (e trata-se da maior parte dos casos) a quantidade numérica nio tenha representagio exacta,
em binario, por utilizagio de “apenas” 52 bits, é cometido um erro de representagio. A menor

quantidade representavel em precisio dupla (272 ) é designada em Marlab por eps

>> eps
ans =
2.2204e-016

Chama-se aqui 4 atengio para esse facto, ndo pelas implicagdes que tem na precisio dos clculos,
nesta cadeira, mas porque aquele di origem a um erro muito comum na utilizagio dos
operadores relacionais. Considere por exemplo as variaveis

>> a=5/7.2
a =
0.6944
>> b=5/(3.1+4.1)
b =
0.6944
>>

Teoricamente a duas quantidades sdo iguais, no entanto, pode verificar que, em resultado do erro
de representagio, resulta

>> a-b

ans =
-1.1102e-016
>>

Um valor desprezavel (eps/2), evidentemente, se ndo estiverem em causa decisdes tomadas sobre
a igualdade das quantidades ... E se, baseado no facto de as quantidades serem teoricamente
iguais, e ignorando a existéncia de erros de representagio, vocé tomasse uma decisio com base na
igualdade

>> if (a==Db)

c=1;
else

c=2;
end

>>
Como vé o resultado era catastrofico. Conclusio:

Nunca baseie decis6es com base em critérios de igualdade entre quantidades numéricas reais

O que fazer entdo, bem .., jA que a quantidade eps esta definida, podemos, por exemplo, fazer
>> 1if (a-Db)<eps
c=1;
else
c=2;
end
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Uma das utilidades dos operadores relacionais ¢ o da selecgio eficiente de elementos de uma
matriz, ou vector, e construcio de novos vectores. Por exemplo, construindo o vector v com os
valores absolutos dos inteiros entre —5 e 5, recorrendo a fungéo abs

>> v=abs (-5:5)
v =

5 4 3 2 1 0 1 2 3 4 5
>>

é facil construir um vector vy com o valor 0 sempre que v; >2 e o valor 1 sempre que

U1S2

>> v2=v<=2
v2 =

0 0 0 1 1 1 1 1 0 0 0
>>

ou saber quais s3o os indices de v para os quais v; = 4, recorrendo 2 fungéo find

>> find(v>=4)
ans =

1 2 10 11
>>

ou substituir os valores de v que verificam v; >4 por 0

>> v (find (v>=4))=0
v =

0 0 3 2 1 0 1 2 3 0 0
>>

Para os operadores 16gicos em Matlab sdo utilizados os simbolos

AND OR NOT XOR

& | ~ xor

Existe um nmero imenso de fungdes pré-definidas em Marlab, pelo que seria fastidioso estar
aqui a enumerar e descrever a funcionalidade de cada uma delas. A estrutura de directérios em
disco em que o Matlab esta instalado, reflecte os diversos grupos de fungdes existentes. Para
conhecer os diversos grupos de funcdes faca browsing do directério . .. \toolbox\matlab\.

o B W e W W

audio datafun datatypes demos elfun elmat funfun general

'8 P 8 B P P B B

graphzd graphad graphics jcans iofun lang matfun ops

] J ot st - - ] ]
palefun sparfun spechun specgraph skrfun tirnefun uitools werchrl
)

winfun

Por exemplo, as fung¢des elementares estdo no directorio [C:\MATLAB] \toolbox\matlab\elfun etc.
Para conhecer o conjunto de fungées elementares, ou, em qualquer momento, recordar a
sintaxe de alguma delas, faca help elfun
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>> help elfun
Elementary math functions.

Trigonometric.
sin - Sine.
sinh - Hyperbolic sine.
asin - Inverse sine.
asinh - Inverse hyperbolic sine.
cos - Cosine.
cosh - Hyperbolic cosine.
acos - Inverse cosine.
acosh - Inverse hyperbolic cosine.
tan - Tangent.

Para conhecer o conjunto de fungées de analise de dados, ou, em qualquer momento, recordar
a sintaxe de alguma delas, faca help datafun

>>help datafun
Data analysis and Fourier transforms.
Basic operations.

max Largest component.

min - Smallest component.
mean - Average or mean value.
median - Median value.

std - Standard deviation.
var - Variance.

Para conhecer o conjunto de fungées de manipulagio matricial, ou, em qualquer momento,
recordar a sintaxe de alguma delas, faca help elmat

>> >> help elmat
Elementary matrices and matrix manipulation.
Elementary matrices.

Zeros Zeros array.

ones - Ones array.

eye - Identity matrix.

repmat - Replicate and tile array.

rand - Uniformly distributed random numbers.
randn - Normally distributed random numbers.
linspace - Linearly spaced vector.

logspace - Logarithmically spaced vector.

Para conhecer o conjunto de fungées matriciais, ou, em qualquer momento, recordar a sintaxe
de alguma delas, faga help matfun

>> help matfun

Matrix functions - numerical linear algebra.
Matrix analysis.
norm - Matrix or vector norm.
normest - Estimate the matrix 2-norm.
rank - Matrix rank.
det - Determinant.

Para obter informagio sobre qualquer das fungdes, ja sabe, faca help <func>. Por exemplo

>> help linspace

LINSPACE Linearly spaced vector.
LINSPACE (X1, X2) generates a row vector of 100 linearly
equally spaced points between X1 and X2.
LINSPACE (X1, X2, N) generates N points between X1 and X2.
For N < 2, LINSPACE returns X2.
See also LOGSPACE,

>>
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3. Representacao grafica

Uma das grandes vantagens do ambiente Marlab é a existéncia, e facil utilizagio, de fungdes de
criagio e manipulagio de graficos 2D e 3D.

Admita que pretende representar graficamente a fungio f(x) = cos(z) no intervalo [0,2r]. A

primeira coisa a fazer é criar um vector com valores da varidvel independente no intervalo
pretendido. Vamos, por exemplo, criar 100 valores de z, equiespagados, no intervalo [0, 2r].

>> x=linspace (0,2*pi,100);
>>

Seguidamente criamos um vector com o correspondente valor da fungio em cada um dos
pontos

>> y=cos (x);
>>

Estamos agora na posse de tudo o que é
necessario para representar a fun¢io: um vector
de valores da abcissa e um vector dos
correspondentes valores da ordenada. Para
fazer a representagao gréﬁca recorremos a
funcao plot

>> plot(x,vy)
>>

Obtemos assim o grafico que se mostra na

figura M1.1. Figura M1.1

E se estivermos apenas na posse do valor da
fungio a representar, desconhecendo os valores
da variavel independente que lhe deu origem?
Nesse caso fazemos

>> plot(y)
>>

s sendo a representacao feita em funcio dos
indices do vector (no caso presente de 1 a
100 ), como pode ver na figura M1.2.

Admita agora que o valor da fungio ¢é
c[alculildo em apenas 10 pontos do intervalo Figura M1.2
0,27 .

>>> x=linspace (0,2*pi, 10); 08l
>> y=cos (x);

>> plot (x,V) o6r 1

>> 04 1
Pode observar o grafico resultante na figura 0l i
M1.3. Nio lhe parece um cos()? O que podera o ]
ter corrido mal? Bem, nio esqueca que estd a 02| |
representar um conjunto de pares ordenados 04} ]
(xz,y) que constituem, neste caso, 10 pontos o6l ]

em R2. A funcio plor permite que se o |

especifique um simbolo para os pontos a 0 1 2 3 4 5 6 7
representar, assim como o tipo de trago que os
une. Por exemplo, repitamos a representacio
anterior, mas especificando agora que cada um

Figura M1.3
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dos pontos no plano deve ser representado pelo
simbolo o, e os pontos devem ser unidos por
uma linha a tracejado.

>> plot(x,y,'o:")
>>

Obtemos assim o grafico da figura M14. E
agora facil interpretar a figura M1.3.

Podemos optar por representar os pontos no
plano sem qualquer linha de uniio. Optemos
por representar 20 pontos da fungio, usando
agora o simbolo *

>> x=linspace (0,2*pi, 20);
>> y=cos (x);

>> plot(x,y,"'*")

>>

Caso pretendéssemos unir os pontos por uma
linha continua farfamos

>> plot(x,y,'-*")
>>

Obtemos assim os graficos das figuras M1.5 e
Ml.6.

Por defeito, a fungcao plot nido usa qualquer
simbolo para representar os pontos no plano e
une as sucessivas posicoes dos pares
ordenados por segmentos em linha continua.
Nunca esquega este facto.

Se o nimero de pontos em que calcula a
fun¢do a representar nio for suficiente, pode
resultar que a interpretagio do grafico
resultante seja completamente errada. Nio
esqueca que, na maioria dos casos, vocé pode
ndo saber qual é o comportamento da funcio a
representar, ¢ o que a representagio grafica
pretende é  exactamente  ilustrar  esse
comportamento. Por exemplo, considere que o
cos() a representar tem uma frequéncia muito

mais elevada, digamos 20 x, g(z) = cos(20z),

fagamos a sua representagio no intervalo
[0,2], mas usemos apenas 20 pontos,

criando para isso um novo vector

>> x=linspace (0,2*pi, 20);
>> y2=cos (20*x) ;

>> plot(x,yl, '-*")

>>

O grafico resultante é o que se mostra na figura
M1.7. Compare-o com figura M1.6. Sio iguais!?
A fungio y = cos(z) e yy = cos(20x) tém o

mesmo comportamento no intervalo [0, 27 ] ?

Na verdade, o ntimero de pontos escolhido
para representar g(x) € excessivamente
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pequeno. Vamos agora representar g(z) usando um nimero de pontos muito mais elevado, por

exemplo 800, e vamos sobrepor o grafico assim obtido ao grafico da figura M1.7. Para sobrepor
os graficos usamos o comando hold on, este permite segurar o espago grafico em que estamos a
trabalhar, de modo que a partir dai todas os graficos serdo executados sobre esse mesmo espaco.
Se quisermos libertar de novo o espaco grafico usamos o comando hold off. Para além disso,
para melhor distinguir os dois graficos, vamos executar o segundo a vermelho (red).

>> x=linspace (0,2*pi, 20);
>> y2=cos (20*x) ;

>> plot(x,y2,'-*")

>> hold on

>>

>> x=linspace (0,2*pi,800);
>> y3=cos (20*x) ;

>> plot(x,y3,'r")

>> hold off

>>

|
1 r m T

08
06
0.4
02
07\““\‘\
02|
L |
04| | ‘ Lol
|
o6k | 1]

o8- ] ]

Al

Figura M1.8

Pode ver o grafico resultante na figura M1.8. Podemos ver agora o verdadeiro comportamento
da fungio g(z) = cos(20x). Pode compreender agora a figura M1.7: como, por defeito, o Matlab

une os sucessivos pontos do vector a representar, o grafico resultante provoca a ilusio de se tratar
de uma fungio cos() com uma frequéncia muito mais baixa, nio tendo na verdade nada a ver

com o verdadeiro comportamento da fungio que se deseja representar.

Execute 0 comando help plot para um completo esclarecimento sobre todos os argumentos
que a fungio plotr pode receber, e siga as diversas funcdes see also para conhecer as
funcionalidades das diversas fungdes que lhe permitem controlar o aspecto do espago grafico. Os
exemplos seguintes procuram ser suficientemente esclarecedores sobre as principais opgdes.
Procure interpretar a linhas de c6digo observando as figuras e recorrendo ao #elp.

e Representagio simultinea de varias Exemplo 1
fungoes.

e Controle da cor, do simbolo e do tipo
de linha de representacio.

e Inser¢io de grelha.

fx)

o Insercio de etiqueta em cada um dos
€1xos.

e Insercio de nome de figura..
o Insercio de legenda

x=linspace (0,2*pi, 30);
yl=cos (x);
y2=sin(x);

Figura M1.9

plot(x,yl, ':oxr',x,y2,"'-*b");
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grid on;

xlabel ('x"');

ylabel ('f(x)");

axis ([0 2*pi -1 11);
title('Exemplo 1'");
legend('cos', 'sin');

e Representagio simultinea de varias
fungoes recorrendo a uma matriz.

e Eliminacio da caixa de legendas.

x=[2:0.1:5];

Y=[x; x.72; x.73; exp(x)];
plot(x,Y,'-0");

legend('x', 'x"2"','x"3"','e"x"',2);
legend boxoff

grid on

e Representagio simultinea de varias
fungoes recorrendo ao comando hold
on.

e Insergdo de texto no espago grafico.

w=0:0.01:6;
fl=cos (w) .*exp (w/4)-1;
plot(w, £f1, 'LineWidth',2);
grid on;

hold on;

f2=cos (w) ;

pIQZ(w,fZ); Figura M1.11
grid on;

text(1.3,0.5, '"\leftarrow \fontname{Garamond}\fontsize{l4}cos(\omega 1i)"');
text (0.6,-2.5, '\fontname {Garamond}\fontsize{l4}cos (\omega i) e”{ j

\omega i/4} \rightarrow');
hold off

Por vezes ha conveniéncia em fazer a representagio simultdnea de varias funcdes na mesma
janela grafica sem fazer a sua sobreposi¢io. Em Matlab isto pode ser feito através da fungéo
subplot. A funcio subplot(m, n, i) cria uma janela grafica, define sobre essa janela uma matriz de
m xn espagos graficos e activa o elemento i da matriz. Seguidamente, sobre esse elemento i
pode fazer o grafico desejado através, por exemplo, da fungio plot. Dio-se seguidamente varios
exemplos que se consideram auto-explicativos. Interprete as linhas de codigo por observagio das
figuras e recurso ao comando help subplot.

| | | | |
e Representacio de fungdes em coluna. oo R P
| | | | |
2= [ N N [
x=0:0.01:6; booo- e ]
fl=exp(x/4)-1; : | : :
f2=cos (%) ; % 1 2 3 4 5 6

subplot (2,1,1);
plot(x,fl);
grid on;

subplot (2,1,2);
plot(x,£2);
grid on;

Figura M1.12
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Representagdo de fungdes em linha.

x=0:0.01:6;
fl=exp(x/4)-1;
f2=cos (%) ;

subplot (1,2,1);
plot(x, fl);
grid on;

subplot(1,2,2);
plot(x, £2);
grid on;

Representagio  sobre uma matriz

2x2.

x=0:0.01:6;
fl=exp(x/4)-1;
f2=cos (%) ;
f3=sqrt (x);
fd4=sin (x);
subplot (2,2,1);
plot(x, fl);
grid on;
subplot(2,2,2);
plot(x, £2);
grid on;
subplot(2,2,3);
plot(x, £3);
grid on;
subplot (2,2,4);
plot(x, £4);
grid on;

Variantes

%x=0:0.01:6;
fl=exp(x/4)-1;
f2=cos (x);
f3=sin(x);
subplot (2,2,1);
plot(x, f1);
grid on;
subplot (2,2,2);
plot(x, £2);
grid on;
subplot(2,1,2);
plot(x, £3);
grid on;

Variantes

x=0:0.01:6;
fl=exp(x/4)-1;
f2=cos (x);
f3=sin(x);
subplot(2,2,1);
plot(x, fl);
grid on;
subplot(2,2,3);
plot(x, £2);
grid on;
subplot (1,2,2);
plot(x,£3);
grid on;

LR11D

Figura M1.16
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) T 1 1 1 LT

Nem sempre estaremos interessados em dar a e -7

tlusio de que a quantidade representada, que é o8- - e e et e -

sempre a sequéncia de elementos de um vector 04f —— - }—*— B S
7 . . | | | | *

e portanto é inerentemente discreta, que a 02— - EaRE EEE R R R TR - ==
. . , [ I I I

quantidade representada, dizia-mos, é uma oF——-- N S S
. h | | | | |

sequéncia continua de valores. 02— Bt DR EEETEEPEEEEEE
| | | | |

. R s A

Utilizando a fungio plot podemos realgar que a 06— - ey o

quantidade a representar é um conjunto o8 ———- U R S -
. . | | | | |

discreto de pontos. Por exemplo, especificando al 4 LS UL L |

o simbolo * e sem linha de ligagio

n=0:0.25:6;
f=cos (n) ;
plot(n, £, '*")
grid on;

Podemos dar um realce ainda maior a
caracteristica  discreta da quantidade a
representar recorrendo 4 fungdo stem. Por
exemplo

n=0:0.25:6;
f=cos (n);
stem(n, f)
grid on;

Recorra ao comando help stem para conhecer
os parimetros que a fungio sfem aceita.
Podemos por exemplo representar os pontos a
cheio

n=0:0.25:6;

f=cos (n);
stem(n, f, 'filled")
grid on

Por vezes é importante realcar que se estd na
presenca de um fenémeno que embora
representado por um conjunto discreto de
pontos, respeita a evolugio de uma
determinada fun¢io continua. Podemos nestes
casos utilizar, no mesmo espago grafico, a
funcio plot e a fungio stem

x=0:0.1:12
fl=cos(x).*exp(-x/4);
plot(x,£f1l,':k");

hold on

n=0:12;
f2=cos (n) .*exp(-n/4);
stem(n, f2, 'filled")
grid on

hold off
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4. Complexos

LR11D

A unidade imaginaria, j = /-1, é representada em Martlab quer pela letra i, quer pela letra ;.

Podemos facilmente criar uma variavel, ou um vector complexo

>> z=2-33
7z =

2.0000 - 3.00001
>> z1=[2.1-3.43 1+2.0j 2-j 1.5+7j]
z1l =

2.1000 - 3.40001
>>

1.0000 + 2.00001

2.0000 - 1.00001

1.5000

+ 1.00001

A representac¢io grafica de um complexo ndo deve ser feita recorrendo a fungdo plot. O Matlab
colocar4 sequencialmente os valores complexos no plano, representando a parte imaginaria em
fungio da parte real, e unilosd com uma linha continua, donde resultarda um grafico

provavelmente irreconhecivel.

>> plot(zl)
>> grid on
>>

Veja o grafico resultante na figura M1.21.
Podemos verificar o procedimento calculando
a parte real dos complexos com a fungéo real ¢
a parte imaginiria com a fungido imag, €
representando graficamente a parte real em
fungio da parte imaginaria.

>> rzl=real (zl)

rzl =
2.1000 1.0000 2.0000

1.5000
>> izl=imag(z1l)
izl =

-3.4000 2.0000 -1.0000
1.0000
>> plot(rzl,izl,'ok:');grid on
>> xlabel ('Rel (zl1l)');
>> ylabel ('Imag (zl1l)');

>>

Este ndo é o modo conveniente de representar
um complexo. A representagio devera ser feita,
por exemplo, através de um diagrama polar,
recorrendo a fungao compass

>> compass (zl)
>>

Observe e interprete a figura M1.23. Podemos
verificar o moédulo e o argumento de cada
vector complexo recorrendo, respectivamente, a
funcgao abs ¢ 4 fungio angle

>> mzl=abs(zl)

mzl =

3.9962 2.2361 2.2361
1.8028
>> azl=angle(zl)
azl =

-1.0175 1.1071 -0.4636
0.5880
>>

Note que o 4ngulo estd expresso em radianos.
Podemos facilmente converte-lo em graus, para
uma melhor interpretagio da figura

>> gz1l=az1*180/pi

Imag (z1)

2
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I I
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I
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I I
I I
4 I I
1 15 2
Figura M1.21
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Figura M1.22

Figura M1.23
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gzl =
-58.2986
>>

63.4349 -26.5651

33.6901

LR11D

Pode fazer a conversio recorrendo as fungées rad2deg ¢ deg2rad

>> rad2deg(azl)

ans =

-58.2986 63.4349 -26.5651 33.6901
>> deg2rad(gzl)
ans =

-1.0175 1.1071 -0.4636 0.5880
>>

Outro modo de representar convenientemente
um vector complexo é o tracado de dois
graficos em separado, um com a representagio
das componentes reais e outro com a
representagio das componentes imaginarias,
ou, ainda, um grafico com a representagio dos
modulos e outro com a representagio dos
argumentos. Estas representagoes sao
incontornaveis  sobretudo  para  vectores
complexo de grandes dimensdes. Considere
por exemplo a fungio

f(z)=0.9" 057

com z €[0,6m]. O recurso & fungio compass

resulta num grafico incompreensivel. Quanto
muito poderiamos recorrer 3 fungéo polar para
representar a evolugio do afixo do complexo
no plano de Argand. Veja a figura M1.24.

x=0:0.01:6*pi;
f=0.9."x.*exp (J*x);
figure(1);

polar (angle(f),abs(f),"'."):

Mas o mais comum seria representar o modulo
e o argumento. Veja a figura M1.25.

figure(2);
subplot(2,1,1);
plot(x,abs(f),'k");
grid on;
title('"|£(x)1");
subplot(2,1,2);
plot(x,angle(f), 'k");
grid on;
title('arg(f(x)) ")

Ou a parte real e a parte imaginaria. Veja a
figura M1.26.

figure (3);
subplot(2,1,1);
plot(x,real(f),'k");
grid on;

title('Real (f(x))");
subplot(2,1,2);
plot(x,imag(£f),'k");
grid on;
title('Imag(f(x))"');

Figura M1.24

176l

Figura M1.25

Real(f(x))

Figura M1.26
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5. Controlo de fluxo.

Tal como nas linguagens de programacio que ja conhece, existe em Marlab a instrugio if, que lhe
permite executar condicionalmente um dado conjunto de instrugdes, atendendo a veracidade ou
nio de uma dada condigdo. Execute o comando help if para conhecer a sintaxe da instrucio de
controlo de fluxo if. Dio-se seguidamente alguns exemplos (Crie um ficheiro .m com as linhas
de codigo, execute-o e interprete os resultados)

elseif c<a
d=1
else

Como sabe, a instrugio for permitedlhe a repeticio de um conjunto de instrugdes. Execute o
comando help for para conhecer a sintaxe da instrugio for. Por exemplo

n=0;

for i=1:10
n=n+1;

end

Dado que o Marlab é uma linguagem interpretada, e dadas as suas capacidades de vectorizagio, o
recurso a ciclos for deve ser reduzido a0 minimo estritamente necessario.
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6. Alocacao de memoria. Vectorizacao

Como se disse, os operadores aritméticos basicos sdo, em Matlab, por defeito, operadores
matriciais. Embora ni3o o tivéssemos explicitado, reparou com certeza que as fungdes pré-
definidas podem receber como argumento vectores ou matrizes, ndo sendo necessario escrever o
cbdigo necessario para a aplicagio da fungio a cada um dos elementos dessas estruturas. Por
exemplo, considerando um vector, v, com valores no intervalo [07 27r], para criar um vector

, Vg , cujos elementos sejam o valor do seno de cada elemento do vector v, basta fazer

v=0:0.1:2*pi;
v2=sin (v);

Se o argumento da fungio seno fosse um escalar, seria obrigado a construir um ciclo for que
percorresse todos os elementos do vector v

v=0:0.1:2*pi;

for i=1:length(v)
v2(i)=sin(v(i));

end

O conjunto de instrugdes acima infringe duas regras fundamentais que deve ter sempre em
atengio na escrita do seu codigo:

. Nunca alocar memoéria dinamicamente
. Nunca executar ciclos for desnecessariamente

No conjunto de instrugdes imediatamente acima, o vector v, nio tem dimensio definida antes

de entrar no ciclo for. Como em cada ciclo a sua dimensio é acrescida de uma unidade de
memoria, isso implica a existéncia de um pedido de reserva de memoria por ciclo, o que torna o
algoritmo altamente ineficiente. Sempre que seja necessario executar um ciclo de calculo, deve ser
alocada memoria para as varaveis nele intervenientes, especificando a sua dimensio final e
preenchendo as variaveis a ser utilizadas com zeros. No caso do exemplo acima, deveriamos ter
escrito

v=0:0.1:2*pi;

lv=length (v);

v2=zeros (1l,1v);

for i=1:1v
v2(i)=sin(v(i));

end

Se o nimero de ciclos for muito grande, a diferenca entre os tempos de processamento é muito
significativa. Podemos verificar isso facilmente

clear all
v=linspace (0,2*pi, 10000) ;
lv=length (v);
v2=zeros(l,1v);
tO0=cputime;
for i=1:1v

v2 (i)=sin(v(i));
end

299009900000 00090000900009000000

v=linspace (0,2*pi, 10000) ;

tO0=cputime;

for i=1:1v

v2 (i)=sin(v(i));

end

tsa=cputime-t0;

disp(sprintf ('Tempo de processamento com alocagdo de memdéria: $2.1f
ms',tca*le3d));

disp(sprintf ('Tempo de processamento sem alocagdo de memdria: $4.1f s
\n',tsa));

disp(sprintf ('O tempo sem alocagdo é %4.1f x superior ao tempo com
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alocacado',tsa/tca));

Num Pentium IV 1.7 GHz a resposta devera ser, tipicamente

>>
Tempo de processamento com alocacédo de meméria: 15.0 ms
Tempo de processamento sem alocacdo de memdéria: 0.8 s

O tempo sem alocagdo é 50.0 x superior ao tempo com alocagdo
>>

Uma vez que o Matlab € uma linguagem interpretada, a existéncia de ciclos de calculo (ciclos for
ou outros) torna os algoritmos escritos em Matlab extremamente ineficientes, uma vez que antes
da sua execugdo cada linha de codigo tem de ser lida e interpretada, sendo na maior parte dos
casos completamente evitavel. Vimos acima que, dado que a fungio seno admite um vector

A

como argumento, o calculo da fung¢io elemento a elemento é completamente desnecessaria.
Vejamos outro exemplo. Admita que, dados dois vectores, v; e vq, pretendemos calcular a soma

do produto ordenado das componentes de cada um dos vectores, ou seja, o seu produto interno

N
<vpvg >= Y vy (i) vy(d)

i=1

Podemos facilmente calcular a diferenca entra os tempos de processamento entre o modo
correcto (vectorizado) e incorrecto (recorrendo a um ciclo for) de escrita deste algoritmo

N=1le6;
vli=rand(1l,N);
v2=rand(1,N);
tO0=cputime;
s=v1l*v2';

cputime;
r i=1:N
s=s+vl (i) *v2(i);
end
end
tsv=cputime-t0

disp(sprintf ('Tempo de processamento com vectorizacdo: %$4.1f ms',tcv*le3d));
disp(sprintf ('Tempo de processamento sem vectorizacdo: %$4.1f ms

\n', tsv*le3));

disp(sprintf ('O tempo sem vectorizacdo é %$4.1f x superior ao tempo com
vectorizacdo',tsv/tcv));

Num Pentium IV 1.7 GHz a resposta devera ser, tipicamente

Tempo de processamento com vectorizacdo: 16.0 ms
Tempo de processamento sem vectorizacédo: 47.0 ms

O tempo sem vectorizacdo é 2.9 x superior ao tempo com vectorizacédo
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7. Scripts e Funcoes

Neste momento ja estd familiarizado com a utilizacio de um ficheiro .m, contendo um conjunto
de comandos que pode executar em sequéncia, escrevendo na consola o nome do ficheiro. Em
Matlab este tipo de ficheiros é designado por script. Todas as varidveis definidas dentro de
ficheiros deste tipo passa, ap6s a execugdo do ficheiro, a fazer parte do espaco de trabalho, isto &,
sdo variaveis globais, podendo ser evocadas na consola ou dentro de outros ficheiros script.

Para além das vantagens ja apontadas, de poder guardar todos os comandos que executa,
identacio do cddigo, e debuging, os ficheiros podem, evidentemente, ser usados para realizar
repetidamente um conjunto de linhas de cbédigo em que, por edicio do ficheiro, se alteram
algumas caracteristicas. Para este tipo de procedimento, no entanto, ¢ mais aconselhavel a
utilizag¢io de fungées definidas pelo utilizador.

Tal como para os scripts, para definirmos uma fun¢io criamos um ficheiro .m. Quando
evocamos o nome do ficheiro, na consola, dentro de um ficheiro script, ou dentro do corpo de
outra fungio, o conjunto de linhas de codigo existente no ficheiro é executado. Para que o
ficheiro .m corresponda a uma fungio e nio a um scripr a 1* linha de codigo deve ter a sintaxe

function [variaveis de saidal=nome da funcdo(variaveis de entrada)

Faz todo o sentido que o nome da funcio corresponda ao nome do ficheiro .m. Note que, se
assim ndo for (por engano) o Matlab reconhece a fungio pelo nome do ficheiro e nio pelo
nome que conste no cabecalho. Ndo use nomes em inglés pois podem entrar em conflito com
fungdes pré-definidas em Marlab.

Todas as variaveis definidas dentro do corpo da fungio s6 tém existéncia enquanto a fungio
estiver a ser executada, isto é, sio variaveis locais, nio podendo por isso ser evocadas fora do
corpo da fungio. Dio-se seguidamente alguns exemplos que se consideram auto-explicativos.
Para qualquer davida, ja sabe, recorra ao comando help function.

Fungdo com apenas um parimetro de entrada e um pardmetro de saida definida num ficheiro
minha media.m

function y = minha media (x)
% Calcula a media dos valores de x

o°

y=sum(x)/length (x);

Uma vez salvo o ficheiro, a fungio pode agora ser evocada a partir da consola, sendo o resultado
atribuido ou nio a uma variavel. Ja sabe, se ndo quiser eco da execugio da fungio use o operador

5

>> media= minha media ([1 2 3 4])
media =
2.5000
>>
>> minha media ([l 2 3 4])
ans =
2.5000
>>
>> media= minha media ([1 2 3 4]);
>> media
media =
2.5000
>>
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Deve habituarse a escrever comentarios logo abaixo do cabegalho, explicativos da utilizagio da
fungdo. Ao fazer help nome da_fungdo estes comentarios sio apresentados na consola, evitando
assim que seja necessario editar a fungio para conhecer a sua funcionalidade.

>> help minha media

Calcula a media dos valores de x
>>

Fungio com trés parimetros de entrada e dois pardmetros de saida definida num ficheiro
meu_heaviside.m

function [n, x] = meu heaviside (n0O,nl,n2)

o\¢

o°

[n, x] = meu heaviside (n0,nl,n2)

o°

o°

Define a fungdo de Heaviside para

valores inteiros entre nl e n2

com o degrau situado em nO.
x[n]=ul[n-n0] ; nl<= n <=n0

o° o°

o°

n=[nl:n2];
x=[ (n-n0)>=0];

Uma vez salvo o ficheiro, a fun¢io pode agora
ser evocada a partir da consola

>> help meu_heaviside

[n, x] = meu heaviside (n0,nl,n2)

|
Define a fungdo de Heaviside para
valores inteiros entre nl e n2 05FL — — — —

|
|
|
S O O |
com o degrau situado em nO. :
x[n]=ul[n-n0] ; nl<= n <=n0 |
>> NN 000N AANAS TR
>> [m, z]= meu heaviside(5,-10,20); I I I I
>> stem(m, 2) s - e i
22 grid on l l l l l
>> axis ([-10 20 -1 217) 4 | | | | I
S>> -10 5 0 5 10 15 20

Note que ao definir uma fungdo esta s6 pode ser evocada se se encontrar na corrente directoria
de trabalho. Se a sua fungio tiver um nome coincidente com uma outra pré-definida, o Martlab
passa a executar a sua fungdo, e ndo a existente algures no sistema de directorias Matlab e
acessivel porque tal directoria esta definida no path.

Se definir um grupo de fungdes que lhe interessa evocar de qualquer directoria de trabalho,
coloque-as numa s6 directoria e junte essa directoria ao seu path. Recorra ao comando help path
para esclarecer o procedimento a ter. Por exemplo, se quiser juntar a directoria
as_minhas_funcoes a0 seu path faga

>>path (path, 'c:\a minha arvorelas minhas funcoes')
>>

Pode assim construir uma biblioteca com as suas proprias fungdes.
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8. Calculo simbolico

Para uma referéncia rapida ao conjunto de fungdes existentes em MatLab no dominio do cilculo
simbolico faca help symbolic. Para uma completa descricio do modo como pode criar e
manipular variaveis e expressdes simbolicas abra a janela help do Matlab, faca uma busca full text
sobre a palavra symbolic e, na subseccio Symbolic Math Toolbox active a op¢io Getting Started.

File Edit Miew Go ‘Web Window Help

Help Mavigatar
4= | & | Findin page:
oduct fiter: (#) A1 () Selected
Symbolic Math Toolhox Getting Star | | Add to Favorites
Contents  Index  Search Den
. ~
Searchiype: |Full Text s Symbolic Math Toolbox

Search for:  |zymbolic | W

Examale arating A0 fgues AAOT G Etti n g Sta'-tEd

exporting
Title: This section describes how to create and use
Symbolic Math Toolbox * symbalic abjects. It also describes the default

swvmbalic vanable.
If you already have a capy of the Maple %, release
4 library, see the reference page for mapleinit

Jsing the Symbolic Math Too
Syimhalic Objects

Creating Symbolic Variables before proceeding.
Symbalic and Numeric Canve Symbolic Objects  Describes symbolic
Creating Symbalic Math Func objects and explaing how

they differ from standard

Extended Symbaolic Math Tool MATLAB data types.

Symhalic Summation

What Are the Symbolic Math T Cre_ating Symbolic E}{plain_s howtn create
“ariables and symbolic objects.

Syrmbalic Math Toolbox Produ
Link to the Symhalic Math Toc

Expressions

—— ) Symbolic and Explaing how to convert

Gettin ed - . .
Mumeric between symbalic objects
Conversions and numeric values.

air Ld

< b Creating Symbolic  Explains how to create o]

Se a Symbolic Math Toolbox estiver instalada, pode manipular expressdes que, além de valores e
variavels numeéricas, contenham variaveis simbolicas. Por exemplo, para definir x como uma
variavel simbblica fazemos

>> syms x
>>
Uma vez definido que = é uma variavel simbélica, podemos, por exemplo, definir fungdes que
envolvam esta variavel,

>> f=2*x"2+3*x-5;
>> g=x"2-x+7;
>>

e fazer uma série de operagdes que envolvam estas fungdes. Por exemplo

>> f+g

ans =
3*xN242%x+2
>>
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>> f-g

ans =

XMN2+4*x-12

>>

>> f*g

ans =
(2*X"2+43*%x=5) * (x"2-x+7)
>>

>> expand (ans)

ans =

2* xMN+xN3+6*x"2+26*x-35
>>

>> f/g

ans =
(2*x"243*x=5) / (x"2-x+7)
>>

>> expand (ans)

ans =

2/ (xM2=-%+T7) *x"2+3/ (x"2=-x+7) *x=5/ (x"2-x+7)
>>

>> pretty (ans)

>>
>> £72

ans =

(2*x"2+43*x-5)"2

>>

>> expand (ans)

ans =

4*x N 4+12*x"3-11*x"2-30*x+25
>>

Note que o Matlab nio faz as simplificagbes ou expansdes automaticamente. Recorremos para
isso A fungéo simplify € A fungao expand. No caso de expressdes demasiado complexas, podemos
recorrer 4 fungéo pretty para uma mais facil leitura. Podemos ainda recorrer a fungao simple,
que tenta encontrar a forma mais simples de escrever uma expressao.

>> f72

ans =

(2*x"2+43*x-5)"2

>> simple (ans)

simplify:
(2*x"2+43*x-5)"2

radsimp:
(2*x"2+3*x-5)"2

combine (trig) :
4% N4+12*%x"3-11*x"2-30*x+25
factor:
(2*x+5)"2* (x-1)"2
expand:
4% x"N4+12*%x"3-11*x"2-30*x+25
combine:
(2*x"2+3*x-5)"2
convert (exp) :
(2*x"2+43*x-5)"2
convert (sincos) :
(2*x"24+3*x-5)"2
convert (tan) :
(2*x"2+43*x-5)"2
collect (x):
4xxM4+12*x73-11*x"2-30*x+25
ans =
(2*x"2+43*x-5)"2
>> pretty (ans)

(2 x + 3 x - 5)
>>
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Outras fungdes de interesse no dominio do calculo simbdlico sdo: a fungdo compose que
determina a expressdo da fungio composta

>> f=1/(1-x"2);

>> g=sin(x);

>> compose (f£,qg)

ans =
1/(1-sin(x)"2)

>>

; a funcao finverse que determina a funcio inversa

>> finverse (qg)

ans =
asin(x)
>>
; a fungéo subs que lhe permite substituir uma variavel simbélica por uma quantidade
numérica.

>> subs (f,x,4)
ans =

-0.0667
>>

; a fungao diff que determina a derivada

>> diff (qg)
ans =

cos (x)
>>

; a fungdo int que determina a primitiva

>> int (f)
ans =

atanh (x)
>>

; a fungao limit que lhe permite calcular o limite da fun¢io quando a variavel simbolica tende
para um valor especificado

>> limit (f,x,0)

ans =
1
>> limit (f,x,inf)
ans =
0
>>
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9. Exercicios M1

Exemplo 1

e (Crie a matriz

NN OO
NN OO
N NN OO O
W W W = = =
W W W = = =
W W W = ==

>> B=ones (3);
>> A=[0*B B;2*B 3*B];

A =
0 0 0 1 1 1
0 0 0 1 1 1
0 0 0 1 1 1
2 2 2 3 3 3
2 2 2 3 3 3
2 2 2 3 3 3

>>

e A partir da matriz A crie a matriz

[0 0 1 1]
00 1 1
001 1

B =
2 2 33
2 2 33
12 2 3 3]

>> B=A;

>> B(:,3:4)=[]

B:
0 0 1 1
0 0 1 1
0 0 1 1
2 2 3 3
2 2 3 3
2 2 3 3

>>

e A partir da matriz B crie a matriz

NN OO
w W o= =

>> C=B(2:5,2:3)
C =

NN O O
w w

>>

o  Altere os elementos 1,13 e 25 da matriz A para 7.

>> A(1:13:25)=7
A:
7 0 7 1 7 1
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NN OO
NN OO
NN OO
wwwrE P
wwwkrE P
wwwrE P

>>

e Seleccione as colunas impares da matriz A

>> A(:,1:2:1length(A))

ans =
7 7 7
0 0 1
0 0 1
2 2 3
2 2 3
2 2 3

>>

e Com base nos conceitos de algebra linear resolva o sistema de equagdes

1 t+x9 + T3 =4
1'1—2.1‘2—.1‘3:—3
T+ Ty =1

Do sistema escrito na forma matricial

11 1]y 4
1 -2 —1||ay|=|-3
1 1 0 ||ayg 1

Resulta de imediato

>> A=[11 1;1 -2 -1;1 1 0]

A =
1 1 1
1 -2 -1
1 1 0
>> a=[4 -3 1]"'

>>

e Gere um vector com os multiplos de 5 compreendidos entre 100 e 200 por ordem
decrescente.

>> v=200:-5:100;
>>
e  Gere um vector com elementos entre 0 e 2 com um passo 7/8 .
>> v=0:pi/8:2*pi;
>>
e Gere um vector v com 40 elementos equiespagados do valor inicial 0ao valor final 77.
Gere um vector vy contendo os elementos de indice par do vector v. Gere um vector vs

contendo os elementos de indice impar do vector v .
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>> v =linspace (0,77,40);
>> v2=v(2:2:1length(v));
>> v3=v(l:2:1length(v));
>>

e Gere um vector, z, com 100 elementos equiespagados pertencentes ao intervalo [— 7, .
>> x=linspace (-pi,pi,100);
>>
e Calcule o valor das fungdes f(z) = sin(z) + cos(x + 7/10) e g(z) = cos(z) + sen(z + w/10)
em 100 pontos equiespagados do intervalo [, 7].
>>f=sin(x)+cos (x+pi/10);

>>g=cos (x)+sin (x+pi/10);
>>

o Trace os graficos das duas fungdes.
Represente f(z) a vermelho com circulos

e linha a tracejado. Represente g(z) a azul

com asteriscos e linha a cheio. Limite a
escala horizontal e vertical aos valores
limite das grandezas  representadas.
Coloque uma legenda e uma grelha no
grafico.

>> plot(x,f,':ro',x,g,"'-*b")

>> grid on>> axis([-pi pi
min(min (g, £f)) max(max(g,f))])

>> legend('f(x)','g(x)"',2)

>>

Trace o grafico do médulo, do argumento, da parte real e da parte imaginaria da fungio
f(z) = ze¥

com x € [07 67r] e incrementos de Relf(x)] Imfx)]

20 20
/8.

>> x=0:pi/8:6*pi;
>> f=x.*exp(Jj*x); 0 0
>> subplot(2,2,1

)
>> plot (x,real (f)) -10 -10
>> title('Re[f(x)]")
>> subplot(2,2,2) -20 -20
>> plot (x, imag (f)) 0 5 10 15 20 0 5 10 15 20
>> title('Im[f(x)]") [f3)| Arg[f(x)]
>> subplot (2,2, 3) 20 4
>> plot (x,abs (f))
>> title('|£(x) ") 15 2
>> subplot(2,2,4)
>> plot (x,angle(f)) 10 0
>> title('Arg[f(x)]")
>> 5 -2
0 -4
0 5 10 15 20 0 5 10 15 20

Defina dois vectores com as fungdes f(z) = 4”2 sen(4r) com gz el0,27] e

flx) = 42 cos(4zx) com x e[~ 7], e ambas as abcissas com incrementos i = 7/100.
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Defina uma funcio Matlab que calcule a soma e a diferenca das duas fungdes. Defina uma outra
fungdo Matlab que trace o grafico de cada uma das fung¢des, da sua soma, e da sua diferenca.

funcaol (x1, f,x2,g,d)

) :d:max (max (x1) ,max (x2));
yl=zeros (1, length )7

y2=yl;

yl(find ((x>=min(x1)) & (x<=max (x1l))==
y2 (find ( (x>=min (x2)) & (x<=max (x2))==

sfg=yl+y2;
dfg=yl-y2;
l

2259595955555 25%55%2%%%%% 1 T ! 1 I I 1 ! I I
N | | | | | | | | | |
function 4l I I I I I I I I I
funcao2 (x1,f,x2,q9,s,d,x) -3 2 -1 0 1 2 3 4 5 6
mx=min (x) ; an ‘ ' ‘ ‘ 9k) ' ‘ ‘ ‘ ‘
Mx=max (x) ; | | | | | | | | |
my-min((£,9,5,d]); N A SRR SR AR R
My=max ([f,g,s,d]): I I I I I | | | |
o) V10 I AR W R4 T N e e — - — ]
| | | | | | | |
subplot (4,1,1) e
plot(xl,£f); | | | | | | | | | |
grid on B R R VWK S S

a}Fls([mx Mx my My]) f(x)+g(x)
title('f(x)") 4 . . . . ; . . . .
subplot (4,1,2); N N
plot(x2,g); L ol B e e i Bt
grid on | P A N S G W S A N W N S
auis (m My Hy]) AR AT
title('g(x)") 2mn- | Bttty i =it Rl e e N B
subplot (4,1,3) ; ) (A O IO A T R S
plot(x,s); -3 2 -1 0 1 2 3 4 5 6

grid on f(x)-g(x)
axis([(mx Mx my Myl) T A~
title('f(x)+g(x)") 2,:, :,,,,:,,,,: ,,:,,,J,,,:,,,,:,,,,:,,,:ﬁ
subplot(4,1,4); | I | | | | | | |
pLot (x, d) ot ==K A NG A AN T
grid on oL NS N ]
axis ([mx Mx my My]) ! | | | | | | | | |
title('f(x)—g(x)') 44 | | | | | | | | |
-3 2 1 0 1 2 3 4 5 6
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10. Auto-avaliacao

Verifique os conhecimentos adquiridos através da resolucio dos exercicios seguidamente
propostos.

e Crie o vector

V=1 2 3 4]

e A partir do vector V' crie a matriz

12 3 4

2 4 6 8
A=

3 6 9 12

4 8 12 16

e A partir da matriz A crie a matriz

4 8
B =
6 12
o  Altere os elementos 1,4 e 7 da matriz A para 5.

o  Seleccione as linhas pares da matriz A.

e Gere um vector, z, com 41 elementos equiespagados pertencentes ao intervalo [0, 27].

e Calcule o valor das fungdes f(z) = 3sin(z) e g(x) =2cos(2z) em 41 pontos do intervalo
[027].

o  Trace os graficos das duas fungdes. Represente f(z) a azul com circulos e linha a tracejado.
Represente g(x) a preto com asteriscos e linha a cheio. Limite a escala horizontal e vertical

aos valores limite das grandezas representadas. Coloque uma legenda e uma grelha no
grafico.

e Trace o grafico do moédulo, do argumento, da parte real e da parte imaginaria da fungdo
f(z) = e com z € [0,27] e incrementos 7/16 . Trace os graficos sobre um espago grafico

com 1 coluna e 4 linhas. Coloque titulos em todos os graficos e etiquetas em todos os eixos.

e Recorrendo a biblioteca de cilculo simbdlico do Matlab, calcule

lim sen(x)

z—>0 T

lim sen(z)

T—>0 x
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